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CMS Training: Contributor  

15 May 2023 

Exercises 

For each exercise there is a basic part and an advanced part. Basic parts 

should be completed by everyone attending the course. Advanced parts are 

optional and can be completed if you finish the basic parts. You might also 

consider working through the advanced parts in your own time after the 

training session.  
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Exercise 1 – Preparation 

Basic (A-D): Prepare for your new page by uploading a photo to the Media 

Library and creating a variant. 

Advanced (E): Find and upload a PDF file to the Media Library. 

A. Find your Media Library category 

1. Open the CMS by opening a browser and typing cms.aber.ac.uk into the 

address bar. Log in using your usual username and password. 

2. Click on the Content menu on the left of the screen and select Media 

Library. 

 

3. Expand the 'Categorised' category on the left of the Media library by 

clicking on the plus sign next to it so that you can see the Training 

category within it. 

4. Expand the Training category.  
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5. Scroll down to find the appropriate year and month, then find the sub-

category with your name on it and expand it. 

6. Click on the Images sub-category.   
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B. Find an Image 

1. Open a new tab in your browser (shortcut is ctrl+t). 

2. Type this address: www.aber.ac.uk/cmstraining.  

3. Right click on the image you would like to use and choose ‘Save Image 

As’ 

4. Save the image on the PC you are using (e.g. on the desktop) so that you 

can find it in a moment. 

5. Close the tab and return to your T4 tab. 

  

http://www.aber.ac.uk/cmstraining
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C. Upload your Image 

1. Click on the Add Media button at the top right of the page. 

 

2. The General Media Information screen opens: 

 

3. Click on the grey box next to ‘Media file’ and find the image that you 

downloaded. Click on the Open button. 

4. Leave the Media type set to ‘Image’. 

5. Type a name for the image in the Name box – this could be the image’s 

filename. 

6. Click the ‘Save changes’ button to finish. 
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D. Create a Variant of your image 

1. Click on the ‘Actions’ button to the right of your image and choose 

‘Variants’ from the menu that appears: 

 

2. The ‘Media variants’ screen appears: 
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3. Click on the Resize button to switch to Resize mode:  

 

4. Create a variant of the image that is a sensible size for a web page by 

checking that the ‘Maintain aspect ratio’ box is ticked, and then typing 

300 in the W box. As you type the height (H box) will change 

automatically to keep the image in proportion. 

5. Click into the ‘Variant name’ box and name your new variant (e.g. Tulips-

300). 

6. Scroll down beneath the image and click the ‘Save variant’ button. 
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7. Your new variant should appear at the bottom of the screen in the 

‘Existing variants’ area: 

 

8. Scroll up and click ‘Media Library’ in the Content menu on the left of the 

screen to return to the Media Library. 

 

Useful Tips:  

You could create more than one variant of an image to be used in different 

locations. You can also crop an image to only use part of it. 
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E. Prepare a PDF file (Advanced) 

Find a PDF or Word file on your PC that you wish to use in your page and 

make a note of where it is located. If you don’t have one, visit a website to 

find one and save it to your PC. 

Based on the principles in the steps above, upload your PDF into your 

category of the Media Library. Note: When uploading a PDF, it is important 

to include a Description – this will be used as the link text for the PDF when 

you insert it into your page. 
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Exercise 2 – Adding the main text of the page  

Basic (A-E): Add a piece of General Content to your section; do basic 

formatting, add a table, links, an image and a link to a PDF or Word file. 

Advanced (F): Add Related Links to your page. 

A. Add General Content 

1. Return to the Site Structure by clicking on Site Structure symbol in the 

menu at the top right of the screen:  

2. Expand the section with your name on it by clicking on the plus sign to 

the left of it. 

3. Click on your About Me section. 

4. Click on the Content tab. 

5. Click on ‘Add Content’ on the top right of the page 

 

6. Click on the template named ‘General Content’ – the General Content 

template appears. 
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7. Type a name for this piece of content in the Name box (e.g. About Me 

General Content). 

8. Type the main heading of the page into the Title box (e.g. About Me). 

9. Type some text into the Body box. 

10. Create a Heading 2, a bulleted list, and some bold and italic text: 

a. Heading 2: Type the text for your heading, then select it and click on 

the Format menu. Put your mouse over Formats, then in the 2nd menu 

put your mouse over Formats, then Headings, and choose Heading 2 

b. Bulleted List: Click on the bullet list button, and start typing your list. 

c. Bold: Select the text and click on the B button.  

d. Italic: Select the text and click on the I button. 

11.  Click ‘Save changes’ to save your work. 
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12. Preview your page: 

a. Return to the Site Structure by clicking on the Site Structure symbol at 

the top of the screen. 

b. Click on the ‘Actions’ button to the right of your About Me section and 

choose ‘Preview section’ from the menu that appears. 

 

c. The preview of the page will open in a new tab – leave the tab open 

when you’ve finished looking at the preview so that you can reuse it 

later as you continue working on the page. 

 

 

 

Useful Tips:  

If the preview doesn’t appear, check at the top of your browser for any 

messages blocking popups. 
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B. Insert a Table 

1. Return to your newly added content by clicking on the section name, 

clicking on the Content tab, then clicking on the piece of content. 

2. Create a blank line where you wish your table to be created and place 

your cursor in the line. 

3. Click on the Table menu, choose either 'Insert table with column 

headings' or 'Insert table with column and row headings' (as required) 

and select the number of cells you need by moving your mouse across the 

grid: 

 

4. The table will appear in the editor window. The headers will be pre-filled 

with text so you can see them clearly: 
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5. Click into the table and replace the default headings with your own text. 

6. Click in each cell of the rest of the table and enter the data. 

7. Add an extra row to the table by placing your mouse in the last row, 

clicking the Table menu and choosing Row > Insert row after 

(alternatively you can right click in the last row and choose Row > Insert 

row after). 

 

8. Click 'Save changes' to save your work. 

9. Return to your preview tab from the end of part A and click refresh ( ) or 

press the F5 key – view your new table in your page. 
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Useful Tips:  

When you create a table it will look very small at first – it will stretch as you 

start to type in it. Don’t be tempted to make it wider by dragging out the 

edges. 

All tables should have a header row or a header row and a header column.  

 

C. Insert Links 

1. Return to your content by clicking on it. 

2. Type some text to be used as the link text for your internal link (i.e. a link 

to an Aberystwyth University page that is held in the CMS). 

3. Select the text, click on the Insert/Edit Link icon and choose ‘Insert 

section link’ 

 

4. The 'Select section' pop-up appears: 
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5. Expand the www.aber.ac.uk folder, and then expand the Home folder 

within it. 

6. Pick a section of the website to link to and click on the section’s name. 

7. Your internal link has now been created. 

8. Type some text to be used as the link text for your external link (i.e. a 

link to an external web site, or an Aberystwyth University page that is not 

yet held in the CMS). 

9. Select the text, click on the Insert/Edit Link icon and choose ‘Link to 

external site’ 
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10. Type (or paste) the web address of a web page or web site that is not in 

the University’s CMS (e.g. http://www.bbc.co.uk/) into the ‘Url’ box. 

 

11. Click Save to save. 

12. Your external link has now been created. 

13. Click 'Save changes' in the main content editor window to save your work. 

14. Return to your preview tab from the end of part A and refresh the page – 

view your new links in your page. 

 

Useful Tips:  

Link text should be 'friendly' - this means it should be self-explanatory and 

the user should know where the link is taking them, even if they could only 

see the link text, and none of the text around it. 

When choosing a section to link to in an internal link, be careful not to click 

on the name of the section while browsing through the site structure – only 

click on the + signs to expand sections and look inside them. 

http://www.bbc.co.uk/
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For external links make sure to include the http:// or https:// part of the web 

address. The CMS may try to help you if your web address begins with www, 

and add the http:// for you, but not all web addresses begin this way so you 

shouldn't rely on the CMS to fix up your link. 
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D. Insert Image  

1. Return to your content by clicking on it. 

2. Place your mouse cursor in the line on your page where you want your 

image to be. 

3. Click the Insert file link or image button 

 

4. Find your images sub-category in the Training area and click on it.  

5. Click on the name of the photo you uploaded earlier. 

6. Pick the variant you created earlier by clicking on its name.  

7. The image will now appear in your content editor window.  

8. Double click on the image and the 'Set media attributes' window will pop 

up. 

 

9. Type a brief description of the image in the alt box. 

10. If required, you may choose how you would like to position your image. 

To position it on the left with the text flowing round it, type float-left in the 

class box. If you want your image to be in line with the text, type float-

none in the class box. To centre the image, type centre in the class box.  

11. Click Save to save your changes. 

12. Click 'Save changes' in the main content editor window to save your work. 
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13. Return to your preview tab from the end of part A and refresh the page – 

view your new image in your page. 

Useful Tips:  

The default position of images is on the right of the page with text flowing 

round it. If you are happy with this there is no need to type anything in the 

class box. 

When you make changes to the class box in the image’s media attributes, 

you will not be able to see any difference to the image in the editor.  You can 

only see the effect of these changes when previewing your page. 

Alt text is very important and should always be added for every image. It 

allows users who can’t see the image (for whatever reason) to still get a feel 

for how the page looks. 
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E. Insert PDF file 

1. Return to your content by clicking on it. 

2. Place your mouse in the position where you would like to insert your link 

to a PDF file. 

3. Click on the Insert file link or image button. 

4. Find the PDF sub-category within the main Training category, and click on 

it. 

Note: If you created your own PDF category in Exercise 1E, you should find 

and click on this category 

5. Check that the PDF you want to use has Alt/Description text under its 

name. 

6. Insert the PDF by clicking on its name. 

7. You will now see the description text appearing in your content, linking to 

the PDF. 

8. Click 'Save changes' in the main content editor window to save your work. 

9. Return to your preview tab from the end of part A and refresh the page – 

view your new PDF link in your page. 

 

 

Useful Tips:  

You can only insert a PDF file if it has text in the description box – the CMS 

uses this text as the link text for this PDF. 

Remember that the best place for content is in a web page – only use PDFs 

where necessary (e.g. for long text, or items that the user will need to print 

out and fill in). 



                                      CMS Training Exercises 

Page 23 of 32 

 

 

F. Add Related Links to your page (Advanced) 

Now you have learnt the basic skills of creating and editing content, you can 

create and edit other types of content.  

Use the principles learned in Exercise 2A to create a piece of Related Links 

content. 

Note: when creating your Related Links, you should use a bulleted list in the 

Links box so that the links you choose are styled correctly. Links are created 

in the same way as in Exercise 2C. 

  



                                      CMS Training Exercises 

Page 24 of 32 

 

Exercise 3 – Adding Contact Details & Meta Data 

Basic (A-B): Add Contact Details and Meta Data to your page by Duplicating 

and Mirroring existing pieces of content into your new section.  

Advanced (C): Add extra text to your page by Mirroring & reorder the text in 

the page 

 

Duplicating content creates a copy that can then be amended. You can use it to 

create a page with a similar layout, or to add metadata which is similar across 

various pages. 

Mirroring content creates an identical linked copy of the content. You can use it 

to display the same content in different places without the risk of the content 

falling out of sync. When any of the mirrored items are edited, the changes will 

appear everywhere the content is mirrored. Mirroring is commonly used for 

things like contact blocks that are the same across many pages. 
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A. Add Contact Details 

1. In the "mini site structure" (to the left of the content list), click on your 

main section (the section named after you – e.g. Suzy Shipman). 

2. Click on the Content tab to view the content in this section. 

3. Click on the Actions button to the right of the piece of content called 

“Training Contact” and select 'Mirror' from the menu that appears. 

4. The “Mirror content” pop-up will appear:

 

5. Click on your About Me section. 

6. The content has now been mirrored. 
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Useful Tips:  

After you have chosen the section you wish to place your mirrored content 

into, you will be returned to the section that you were mirroring from. 

As the contact details are mirrored, any edits made will also be made in all 

the other mirrored versions of this content. The symbol in the content listing 

( ) reminds you that this content is mirrored – be careful when you see 

this on other content so that you don’t accidentally edit content that appears 

in other pages. 
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B. Add Meta Data 

1. Click on the Actions button to the right of the piece of content called 

“training metadata” and select Duplicate from the menu that appears. 

2. The “Duplicate content” pop-up will appear: 

 

3. Click on your About Me section. 

4. The content has now been duplicated. 

5. In the "mini site structure" (to the left of the content list), click on your 

About Me section. 

6. Click on the Content tab. 

7. You should now be able to see the training contact and training metadata 

listed. 

8. Click on the training metadata to modify it. 

9. Edit the Meta Authors box with your own name. 
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10. Edit the description to make it specific to your page in the Meta 

Description box. 

11. Edit the keywords to make them specific to your page in the Meta 

Keywords box. 

12. Click 'Save Changes' to save your work. 

 

 

Useful Tips:  

After you have chosen the section you wish to place your duplicated content 

into, you will be returned to the section that you were duplicating from. 

Metadata is not seen on the page but is hidden behind the scenes – it’s used 

by Search Engines.  
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C. Add extra text to your page by Mirroring & reorder the text 

in the page (Advanced) 

Using a similar process to that detailed in 3A 1-4, mirror the “training 

content” from your main section into your About Me section. Now change the 

order of the content in your About Me section so that this one (training 

content) will appear first on the page - look at the list of content and click 

and drag items by clicking on the move icon in the Order column on the left. 

Position training content at the top above the other content. Check your 

preview to see how the text on the page has moved. 
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Exercise 4 – Welsh 

Basic (A): Create a Welsh version of your General Content 

Advanced (B): Create Welsh versions of your other content 

A. Create a Welsh version of your general content 

1. Return to the Site Structure by clicking on the Site Structure symbol in 

the menu at the top right of the screen. 

2. Click on the language change button (top of the page) and select 

Cymraeg. 

 

3. Click on the Amdanaf I section. 

4. Click on the Content tab. 

5. Click on the content marked as 'Not translated'. 

6. Give the content a name, a Welsh title and some Welsh text in the body.  

7. Click on 'Save changes' to finish. 
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Useful Tips:  

If your page has a lot of formatting, you can swap language while you have 

the content open, so that you can copy the English Body and paste it into 

your Welsh version. This should only be done when you have the Welsh text 

ready. 

It’s important to remember that when editing the Welsh version of a piece of 

content for real there should never be English text in it – for this training 

session it’s acceptable to have something like “Welsh text here” but never do 

this on real pages. 

If you move your mouse over the words Not translated in the list of content 

you will see what the content is called in English. This is particularly useful if 

there is more than one piece of content marked as Not translated. 
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B. Create Welsh versions of your other content (Advanced) 

Using a similar process to that detailed in 4A, modify all of your pieces of 

content so that they have Welsh versions. If you completed all the advanced 

exercises you should have 2 additional pieces of content marked as Not 

translated – these will be your Meta Data and Related Links. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Training Evaluation Form:  

https://www.aber.ac.uk/en/is/it-services/web/training-evaluation/ 

https://www.aber.ac.uk/en/is/it-services/web/training-evaluation/

